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St\P2000 

INTRODUCTION 

Generai 

The most famous program used in structural analysis in the last 30 years is 

Stntctural Analysis Program (SAP) which designed by Computer and 

Stntctures, Inc. company (CSJ). This program had been improved from 1970 

up to now. There were many versions had been edited by the company hke 

SAP, SOLJDSAP, SAPJi.< S~4P80, SAP90, and SAP2000. 

S.AP is a finite eiement program for solving structures. In the finite element 

solution, the structure is to be divided into elements intercormected only at a 

finite number of nodal points. The finite element theory assumes that the 

behavior of a structure is similar to that of an assemblage of finite elements to 

which it is divided . 

SAP2000 Versions and Limitations 

SAP2000 may be purchased in the foHowing four versions: 

SAP2000 Standard 

Capacity 

Analysis 

Elements 

1500 Nodes 

Static ~md Dynamic Response Spectrum .Analysis 

FR/\ivlE and SHELL Elements only 

Design Steel (AISC-ASD89, AlSC-LRFD93, BS5950 90, CISC 

95, EUROCODE 3-1992), Concrete (ACI 318-95, BS811 0 89, CAN3-

A23.2-:N184, EUROCODE 2-1991) 
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SAP2000 Plus 

Capacity 

Analysis 

Bridge Analysis 

SAP2000 

No Practical Limit 

Static, Dynamic Response Spectrum, Tune History and 

Elements 

Design 

FRAlvlE, SHELL, PLANE, SOLID and ASOLID Elements 

Steel (AISC-ASD89, AlSC-LRFD93, BS5930 90, CISC 

95, ElJROCODE 3-1992), Concrete (ACI 318-95, BS811 0 89, CAN3-

i~~3.2-l\~184, EUROCODE 2- i 991) 

SAP2000 Nonlinear 

c ·apacity No Practical Limit 

Analysis Static, Dynamic Response Spectrum, Ti..tne History, Bridge 

and Dynamic Nonllnear Time History i\na1ysis 

Elements FRAME, SHELL, PLANE, SOLID, ASOLID, and 

NLLIN'"l( ( as external Damping , Base Isolators, Gap and Hook Elements) 

uesign 
'-

Steei (AISC-ASu89, A.ISC-Lf{fD93, BS5950 90, CISC 

95, EUROCODE 3-1992), Concrete (ACI 318-95, BS8110 89, CAN3-

SAP2000 Educational 

Capacity 

Analysis 

30 Nodes 

Static, Dynamic Response Spectrum, Time History, Bridge 

and Dynamic Noniinear Time History Anaiysis 

Elements FRAiv£E, SHELL, PLA .. NE, SOLID, ASOLID, and 

}.fLUNK (as external Damping, Base Isolators, Gap and Hook Elements) 

• Desi<m b Steel (.AISC-.t\SD89, AISC-LRFD93, BS5950 90, ClSC 95, 

EUROCODE 3--1992), Concrete (ACi 318-95., BS8110 89, CAN3-A23.2-

M84, EUROCODE 2-1991) 
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Advantages of SA.P2000 

• Has a very simple \vay to input data. 

• Ability to input the geometrical data usjng AutoCAD program. 

• Ability to solve any problem edited by using SAP90 program. 

• Ability to use a template models in the program and to modify it. 

• Solving much number of equations up to 60 000. 

• Ability to design some structural elements. 
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STRUCTURAL ANALYSIS PRINCIPALS 

Coordinate system 

When defining any stmcture, 1t IS important to input . the joint coordinates 

values that specif)' the iocation of each joint. So it is necessary to use a 

coordinate system to !ocate the structure elements and to define the direction of 

loads, restraints, dispiacements, reactions, and the resultant forces and stresses. 

I- Giobai coordinate systen1 

It is a coordinate system for all over the structure. The. follow1n~ inpUT ctnt:1 i 

prepared with respect to the global coordinate system: 

1- Joint coordinate. 

2- Joint restraints. 

3- Joirit spring supports . 

4- Joint loading. 

5- Joint constraints. 

The following output data is refened to the global coordinate system: 

1- Joint displacements . 

2- Joint reactions. 

II- Locai coordinate system 

It is a coordinate system for each eiement in the stmc.ture. The fo11owing input 

data is prepared with respect to the iocal coordinate system: 

1- Element section properties. 

2- Element loading. 

The foliowing output data is referred to the local coordinate system: 

1- Element forces . 

2- biement stresses. 
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Types of elements 

It is necessary to know the different types of elements used for defining the 

strnch1re problem such as beams, frames, trusses, slabs, tanks, and rafts. 

Frame element 

Two joints define this element. It can be used for modeling bemns, trusses, and 

frames. 

Plate bending element 

At least three joints are needed to define these element max four joints. It c.an 

be used for modeling slabs (sections under simple bending). 

lVIen1brane element 

At least three joints are needed to define these element max four joints. It can 

be used for modeling domes and folded plates (sections under normal only). 

Sheil elen1ent 

At least three joints are needed to define these eiement max four joints. It c.an 

be used for modeling tanks (sections under moment and normal). 

Restraints and degrees of freedon1 

It is k.llO\VTI th.at every point in space have six components of freedom, \vh.ich 

are three displacements in the three directions Ux, Uy, a..11d Uz and three 

rotations about the tlu·ee axes Rx, Ry, and Rz. 

Existing of any displacement in m1y direction is called a degree of freedom 

(D.O.F) and inability of displacement in a specified direction nl.em1s that this 

freedom is restrained. 
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Frame Element 

FRAME element follows the deslgner·s convention. 

X 

z 

• I 

End I 

/G---~ Y 
~ ... 

Global 

Axis 2 

Axis2 

Axis 3 

Frame Element Local Axes 

Positive Axial Force and Torque 

V2/ 
Axis1 

_-· ··... ,/7 
~ ...... .... 

Positive Moment and Shear in 1-2 Plane 

Frame Element Internal Forces 

Axis 1 

Axis 1 
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Shell Element 

Axis3 

• 
Face 6: Top (+3 face) 
Face 5: Bottom (-3 face) 

j1 

Three-Node Triangular Shell Element 

~Axis 2 

j4 

F-lv~N F-MAX 
. \ ........ .. , ./ , 

( :-: \~ 
/ '·,,/~ 

.--- / ~ · ~ Axis 1 
Forces are per unit , ANGLE _ _,-r 
of in-plane length _.. _./ 

/ Fn\ F1 2 .·'" ----------
j3 / ;;,j· .. _, --;: ·· Positive shear forces and stresses 

... ,.... \\ ·':' ,' r-11 acting on positive faces 
·.\ ~ ' ' >:'·· point toward the viewer 

~------ ·------ ---· "2 
j1 J 

Membrane Forces 

Axis 2 
~ 

Moments are per unit 
of in-P'ane length 

j1 j2 

Plate Bending and Twisting Moments 

Shell Internal Forces 

FINT = F intermediate 

FVM =v{1/2[(FMAX- FINT)"2+( FMAX - FMIN)"2+( FINT- FMIN)"2J}. 

Also See: 
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PROGRAIVI APPLICATIONS 

Define l"taterials 

1- On the Define menu, dick lVIaterials. .. This \\~ll display the Jviaterials 

dialog box with default materials, CONC, OTHER and STEEL listed in the 

Materials list box. 

What do you want to do? 

Add a New Concrete Iviaterial Type 

Add a New Steel Material Type 

Add a New Other 1v{ateri(li Type 

Add a New Concrete l'Viateriai Type 

To Add a New Concrete 1vfateria1 : 

1- In the Materials dialog box, click on Add new Material button. This will 

display the Iviateriai Property Data box. 

2 - In the Iviaterial Property Data box 

• Choose Concrete from the Design Type drop dmvn list. 

• Enter the Material name in the Iv!aterial Na..111e edit box or accept the 

default name. 

• ln the i·..nalysis Property Data area, enter new values for Mass per unit 

vohm1e, Weight per unit volume, .Iviodulus-of Elasticity, Poisson ' s Ratio 

and Co-efficient of thennal expansion, if the default values are not 

acceptable. 

• In the Design Property area, enter the value for Reinforc-ing yield stress 

(~,), Concrete strength (fc), Shear steel yield stress (~,5) and Concrete shear 

str·.:. ngth (fcs) or ac~..:tpi the defauit vaiues. 

• Click OK. 
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SAP2000 

3 -The new Material Name wiil be added to the Materials list box. 

4 -To Delete or iVlodify/Show .Nlaterial, ciick on the. material in the list box 

and then click on the .Nlodify/Show Material or Delete Material button. 

5 - Click OK. 

Add a New Steel i\Jatcrial Type 

To Add a New Steel Material: 

1- In the Ivlaterials dialog box, click on Add new Iviaterial button. This will 

display the .Nfateriai Property Data box. 

1-ln the Ivfaterial Property Data box 

• Choose. Steel from the Design Type drop dmvn list. 

• Enter the Material name in the Material Name edit box or 

accept the default name. 

• In the Analysis Property Data area, enter nev,r values for mass 

per unit volume, \A/eight per tmit volume, rvrodulus of .elasticity, 

Poisson ' s Ratio and Co-efficient of them1ai expansion, _ifthe 

default values are not acceptable. 

• In the Design Property area, enter the value for Steel yield 

stress fy, or accept the default value. 

• Click OK. 

3- The new Material Name will be added to the Iviaterials list box. 

4-. To Delete or Iv1odify/Shmy lv1aterial, click on the material in the list box 

and then click on the lvlodify/Show Ivlateiial or Delete Ivlaterial button. 

5 Click OK 
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Define Static Load Cases 

1- On the Define menu, click Static Load Cases... This \:vill display the 

Static Load Case Names dialog box with a default Load Case, LOAD1 listed 

in the Loads list box. 

2- To add a new Load Case name 

• Type in the new name in the Load edit box 

• Choose the ioad type to be Dead, Live, Quake, V\Tind, Snow or 

Other from the Type drop dmvn list 

• Type in a seif-\:veight mnitipiier in the edit box and 

• Click Add new Load button. 

3- To change a Load C~1se name click on the name in the list box and then type 

over the changes in the edit boxes or choose a different Load Ty-pe fi:om the 

drop down list and dick Change Load button. 

4- To delete a Load Case name click on the name in the list box and click 

Delete Load button. 

5- Click OK. 

Tip: Load Case names defined here are used in Load Combinations. Load 

Case Types are used by :::: :'\P2000 to develop automatic load combinations for 

DesibJTI/Stress Check of the structure. 

Define Load Combinations 

1 On the Define menu, click Load Combinations... This w-il1 display the 

Load Combinations diaiog box. 

2 to add a nev.: Load Combination click Add new Combo button. This wili 

disp!ay the Load Comb1mnion Data dialog box. 
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ln the Load Combination Data dialog box 

• Type in the combination name in the Load Combination Name 

edit box. 

• Select the Load Combination Type: ADD, ENVE, ABS, 

SRSS 

• Type m the title (description of load combo) in the Title edit 

box. 

o Select Anaiysis c·ase names from the Case Name drop dm:vn 

list box and type in the multiplier in the Scale Factor edit box 

and click ADD. This \vill add the A . .nalysis Case and the 

muitiplier to the list box. 

• Simiiariy select other Analysis Cases and add them to the list 

box to complete the Load Combination definition. 

• It is possible to modify or delete an Analysis Case from the 

Combination definition by selec6ng the A .. nalysis Case from the 

list box and c1icking the Iviodify or Delete burton. 

• Select whether the combo shou1d be nsed as a part of the Steel 

or Concrete desib"TJ1 loading combinations. 

• Click OK. This \vill add the . Load Combination to the 

Combinations 1ist box. 

3- To include the defauit design load combinations for the code 

specified in Concrete and Steel Preferences, click on the Add 

Defauit Desib"TJ1 Combo Button. The program \viU add Steel design 

combos if the Steel Desih"TI1 is selected in the Design menu and 

Concrete design combos if the Concrete Desib"TJ1 is selected in the 

Desib"TJ1 menu. The Type assignment for the Stfltic L0ad Case is used 

to detennine the appropriate load factors. 

i i 
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4- To modify a Load Combination, ciick on the name in the Combinations 

list box to select it and then ci1ck Modifv/ShO\v Combo button. This wiil 
.J 

display the Load Combination Data dialog box. rv·iake the appropriate changes 

and then click OK. 

5- To delete a Load Combination, click on the name in the Combinations list 

box to select it and then click Delete Combo button. This will delete the Load 

Combination. 

6- Click OK. 

Tip: Load CuJubinadons detined here are used in Select Design Combos to 

define design-loading combinations. 

Selecting Design Load Combinations 

l- On ihe Design Ivlenn, click Select Design Combos ... This wiii display the 

l)esign Load Combinations Selection dialog box. 

2- In the uesign Load Combinations Selection box: 

~ Select previously defined Combos from the List of Combos 

e Click on Add button to add Combos to the Design Combos list 

• Clicking on Remove button \:vili remove the selected Combos 

from the Design Combos list 

• Click OK 

Note: The Design Load Combinations Selection menu lists a series of default 

load combinations labeled DCON# for Concrete design and DSTL# for Steel 

design. The number and type of default combinations depends upon the static 

Load Cases previously defined. Other user ·defined Load Combos that \vere 
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indicated as design combos in the Load Combination Data dialog box will also 

be included in the Design Combos 

lf other load combinations have been defined and were not indicated as design 

combos in the Load Combination Data dialog box, they are shown tmder List 

of Combos. The Design Combos list can be modified by removing one or more 

default Combinations and/or by adding from the List of Combos. 

Clicking on the Shmv button \Vill present the Load Cases and Scale factors for 

the highlighted Combo. 

FRAfviE SECTION 

Add a Frame Section by defining the dimensions and or properties manually 

1- On the Define menu" click Frame Sections ... This will display the Frame 

Sections dialog box. 

7 - In the Frame Sections dialog box dick on the Add drop dmvn button and 

choose Add l/Wide Flange or Charmel, Tee, AA.ngle etc. by double clicking on 

one of the section types . Tllis ''~ll display a Section Property fonn that shows 

the physical shape and dirnensions of the section. 

3- Enter the section name or accept the default name. 

4 - Enter the physical dimensions of the section or accept the default values. 

5- Choose the mate1iai iype (e.g. Steei, Concrete or Other) from the Material 

drop down list box. For Concrete sections see below. 

6- It is possible to look at the section propetties by clicking on Section 

Properties. 
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7 - You can modify the section properties by pressmg the Modification 

Factors button. There you can change the default factor of 1 that the section 

properties are multiplied by. 

8 -Click OK to accept the selected section . 

9- The new section name will be added to the Name list box. 

10 - To delete or Modify/Shmv Section, click on the Section name in the list 

box to select it and then click on the lvlodify/Show Section qr Delete Section 

button. 

11- Click OK. 

Concrete Section 

For concrete sections you will need to also perform the following steps: 

1- Wl1en you select a Concrete mate1ial type, an additional Reinforcement 

button will appear at the bottom of the fonn. Click the Reinforcement button. 

• In the Reinforcement Data diaiog box, select Element Class e.g. Column 

or Beam. 

For Columns 

• Select the Configuration of Reinforcement ~.g . Rectangular or Circular. 

• Enter the Concrete Cover in the text edit box. 

• Enter the Number of Bars in the 3-Direction in the text edit box. 

• Enter the Number of Bars in the 2-Direction in the text edit box. 

Exampie of Concrete Column j bars m the 3-Direction 2 bars m the 2-

Direction 

• if Circuiar Reinforcement Configuration is selected then enter total 

number of bars. 

• Select and Enter the Area of I Bar or 

J.f 
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• Seiect Design Area of Steel for SAP2000 to automaticaily find the area of 

steel required during design mode. 

For Beams 

• Enter the Top and Bottom Concrete Cover in the text edit boxes. 

• If you want to specify top and bottom steel, enter reinforcement area for 

the section in the appropriate text edit box. Othenvise leave values of zero 

for Si\P2000 to cakuiate the reinforcement automatically. 

• Click OK to retum to the Section Det]nition fonn. 

Draw a Frame Element from .Joint to Joint 

Draw in 2-D 

1- On the View menu ciick Show Grids. Tilis puts a check mark next to it and 

works as a toggle to tum on or Off the Grids. 

2- Select 2-D Plane in which you want to draw the member. 

3 -Click on to switch 10 di·awing a FRAME element between 2 points. 

4- Click on a Grid intersection, a previously defined Joint or any point in the 

plane. Click again on another point to add a single F.RANIE element. tvery 

subsequent dick will add another FRAl'vfE element tmless a double click on the 

same joint is pelfom1ed or the ENTER key is pressed. Pressing the ESC key 

will also tenninate the sequential draw and take you out of the Draw mode. 

Draw in 3-D 

1 -On the View mcmt 0 click Show Grids. This puts a check mark next to it and 

works as a toggie to tum on or off the Grids. 

2 -Click on to switch .to drawing a FRAivlE element between 2 points. 
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3 -in the 3-D vieYv click on a (]rid intersection or a pre\rjously defined Joint ( a 

small red ball appears to con finn that the joint has been selected). 

4- Click on another Ciricl intersection or a Joint to add a FRAME element. 

Every subsequent click on a selected point wiil add another FRAlv'IE element 

unless a double click on the same joint is pe1fonned or the ENTER key is 

pressed. Pressing the ESC key will also tem1inate the sequential drmv and take 

you out of the Drmv mode. 

Note: It is not possible to draw a FRAlviE element between any two arbitrary 

points in space m the 3-D view. 

LOCAL AXIS 

Assign Local A.xes for Frame Elements 

1- Select one or more Frame E1ements to \vhich you want to assign the same 

Local Axes. 

2- On the Assign menu clicks Frame and then Local Axes ... in the sub-menu. 

3- In the Frame Local /\\is di spiay box: 

• Type in a value for .t\ng1e in J)eh'Tees. Tllis is an angle by which local axis 

(2) of the Elemerit wiii be rotated armmd locai axis i. Local axis 1 is along 

the length of the Element. By default local axis 2 is always in the 1-Z plane 

except if the Element is venical and then it is parallel to the global X-axis . 

The defrrution of the iocai axes follow the right hand rule. The angle is 

measured anti-ciock\vise as positive if local axis 1 is pointing towards you .. 

• Check the Reverse stmi and end connectivity box if you want to flip the I 

and J ends of the members i.e. fiip the local axis 1. 

• Ciick the OK button 
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Note: By default giobal Z 1s taken as the 3D View Up Direction. You may 

change the UP direction from the Option pnll down menu. lf you change the 

UP direction, it wi11 only affect the display of the model and does not affect the 

local axes definition in any way. 

Assign Gravity Loaf.ls to Frames 

This loading method is a way to add the factored self-weight of the members in 

as a force m anv oi' the global directions. It is recommended that the ach1al 

self-weight of the structure be included in the definition of the Static Load 

Cases. 

1- Select one or more FR.'\IviES to assib'Tl loads to. 

2- On the Assi£..rn menu click Frame Static Loads and then Gravitv ... in the 
~ J 

sub-menu. This will display the Frame Gravity Loads dialog box. 

3 -In the Frame Graviry Loads dialog box: 

• Se1ect the Load Case 

• Provide Gravity IvJuitipliers 

• 'elect frol"" Ar1r1 -l..,.Pn·l~c.e Delet·e ._, J ... ... 'l1 ~ • '-........ , '\.- l-' u , . 

• Ciick OK . 

The sc.reen \vill refresh with a graphical representation of the load assigned on 

the members selected. 

Assign Point and lJniform Loads to Frames 

1- Select one or more FRAiviES to assign loads to. 

2- On the Assign menu, click Fr£lme Static Loads and then Point and 

Unifonn... in the sub-menn. This wii1 display the Point and Uniform Span 

. Loads dialog box. 

3- In the Point and Unifom1 Span Loads dialog box: 
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• Select Load Case 

• Choose Load Type and Direction 

• Provide Point Loads and Distances 

• Provide Unifom1 Load 

• Select from Addo Repl ace, Deiete 

4- Click OK. 

TI1e screen v .. •ill rehesh wilh a &>raphicai representation of the ioad assigned on 

the members selected . 

Assign Trapezo!tiai Loads to Frames 

1- Select one or more FRAMES to assign loads to. 

2- On the Assign menu click Frame Static. Loads and then Trapezoidal ... in the 

sub-menu. This wiii display the Trapezoidal Span Loads dialog box. 

3- In the Trapezoidal Span Loads diaiog box: 

• Select Load Case 

• Choose Load Type and Direction 

• Provide Loads and Distances 

• Select from Add, Replace, ueiete 

4- Click OK. 

The screen \Vill refresh with a graphical representation of the load assigned on 

the members selected. 
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Assign Temperature Loads to Frames 

1- Select one or more FRAMES to assign loads to . 

2- On the Assif:-'11 menu, click Frame Static Loads and then Temperature . .. in 

the sub-menu. This wiil display the Frame Temperature Loading dialog box. 

3-ln the Frame Temperature Loading dialog box: 

• Select Load Case 

• Select Type from Temperahrre, Temperature Gradient 2-2, Temperature 

Gradient 3-3 

• Selec-t Temperah1re by Element or Joint Pattem 

• Select from Add, Replace, Delete 

4- Click OK. 

The screen wii i refresh with a brraphicai representation of the load assigned on 

the members selected. 

Assign Prestress to Frame Static Load 

. Once the prestress has been assigned to ti1e ii·ame member the load from that 

prestress needs to be assigned to a Load Case for SAP2000 to be able to 

include it in the analysis. 

1- Select the FRA.lVlE Elements for which you \vant the prestress load assigned 

to a defined Load Case. 

2 - On the Assi&rn menu, click Frame Static Loads and then Prestress . . . in 

the sub-menu. This will display the Frame Prestress Loads dialog box. 

• Select the Load Case from the drop dow11 iist box. 

• Set a scale factor for the prestress load. This value is independent of scale 

factor for Load Combinations . 

• Select Add, Replace, and Deiete existing -ioad. 

3- Click OK 
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Assign Frame Prestress 

Assigning Frame Prestress i9ads is a way to model the prestress cable load on 

a frame member. 

1- Select the FR.A.~.i! E Eiements to which you want to assign a Prestress load. 

2- On the Assign menu, click Frame and then prestress ... in the sub-menu. 

This will display the Fn:me Prestressing Parten1s dialog box. 

3- In the Frame Prestressing Patterns dialog box enter: 

o The Cable Tension in the text edit box 

• The Start, Iviiddie and End cable locations. 

• Seiect from f\ dcL Replace or Delete. 

4- Click OK. 

Note: ·rt ou can 2ss1g11 more than one Prestress load to an indi\~dual frame 

member. Once you have assigned prestress loads to dements you will need to 

assign the frame prestress 1oads to static load case . 

Releases are assigned to seiected Frame Elements . 

1- Select the FRAfv'iE Elements to which you want to apply the releases. 

2- On the Assig11 menu click Frame and then releases .. . in the sub-menu. Tllis 

will displav the Frame Releases dialog box. 
~ ~ 

3- ln the Frame Re1eases dialog box: 

• For each end of the FRAivil::. Element check the type of release desired 

(Axial , Shear Force 2 (Iviajor), Shear Force 3 (Iviinor), Torsion, Ivioment 

22 (Iviinor) and Iviornent 33 (Jviajor) . 

• If no releases arc desired then check the No Releases box. 

4- Click OK. 

Note: The reieases specified ah:vays repiace_tile existing releases . 
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Assign.Frame End Offsets 

Frame End Offsets are assigned 10 s.elected Frame Eiements. 

1- Sdect ihe iRA~v·lE U~men1s 10 which you wa;1t to ;}pply the Frame End 

Offsets. 

2- On the Assign menu, click Frame and then End offsets ... in the sub-menu. 

This will display the Frame End Offsets dialog box. 

3- In the Frame End Offsets dialog box: 

• lf you want to use User Specified End Offsets then check Define Lengths 

and type in the values for the Offsets at EnJ I and End J. 

• If you want the program to ealculate the End offsets from the eonnectivity 

of the model then check Update lengths from current connecti\~ty. The 

program wili automatically calculate the End offsets from the Depth 

(Major) and Width (:!Vii nor) ·specified for the Frame Element properties . 

• Speeify a Rigid Zone Factor in the edit box. This is a factor used to 

define tbe percentage of the Zone specified through End Offsets to be taken 

as fully rigid. 0 means no rigid zone and 1 means that the entire zone is 

taken as rigid. 

I~ 
Total Length L 
Clear Length Lc 

I 
Horizontal---.. 
Member ----~ J 

ioff ~End Offsets · jofft 
'1 ,__ 

~ 
-

~-- ~ 
"·· •, ,/ 

"·-..__Support face ___/' 

I I 

- -.. 

\ -t 
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Define .Joint Patterns 

1- On the Define menu, ciick Joint Panems... This wiil display the Pattern 

Naitles Jialog box with a defauit pattem, DEFAULT listed in lhe Pattems list 

box. · 

2- To add a new pattern mune type in the new name in the Pattems edit box 

and click Add new Pattern Name. 

3- To change a pattern name click on the name in the list box and then type 

over the changes in the edit box and click Change Pattern Name. 

4- To deiete a pattem name click on the name in the iist box and click Delete 

Patt~m NmnA 

5- Click OK. 

Tip: Pattern names defined here are used in Assign Joint Patten1s. 

r~ Value = Ax + By + Cz + 0 

Constant A 0 I 

.L 
Constant 8 0 I 

Constant C -20 

11 Cl ~ . ··Constant D 11 0 

Valu e D Cz 
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Assign Joint Patterns 

1- Select the joints to which you want to assign the pattern. 

2- On the Assign menu, ciick joint Panems.. . This wiii dispiay the Pattem 

Data dialog box. 

3- Click on the Pattem Name drop downs box and choose a previously defined 

pattern name by clicking on it. 

4- Type in the values in the edit boxes for Constants A, B, C and D, relevant 

to defirung the Value of i\:x+By+Cz+D ( x, y and z are JOffit coordinates 

relative to the migin of the current coordinate system). lt is this Value that vvill 

be assigned to the joints. lt can define the variation of Temperature for Frame 

Elements and variation of Pressure tor Shell Elements. These Values are then 

subsequently multipl1ed by the Temperature values assigned from the Frame 

Static Loads or Pressure values assigned from the Shell Static Loads. For 

instance if you want to assign a pattern which represents the variation of soil 

pressure on a waii: 

5- Options 

• To add compmed Vaiues from Constants to ex1stmg Values from 

previously assib>ned panems, click on Add to existing values under Options. 

• To replace computed Values from Constants to existing Values from 

previously assigned patterns, click on Replace ex1stmg values under 

Options. 

• To delete previously assigned patterns, click on Delete existing values 

under Options. 

6 - Depending on the pattern you are trying to define select either: 

• Use all values i r ali vrtlues are desired 

• Zero Negaiives V2iues if negative variation is not desired. 

• Zero Positive Values if positive variation is not desired. 

7- Click OK. 
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Note: Once you have assigned the pattern you wili still need to assign a load 

to that pattem by selecting from the assign menu, Shell Static Loads ... 

Pressure .... 

SHELL SECTION 

Add a Sheii Section by defining the dimensions and I or properties 

1- On the Define rnenu, ciick Sheii Sections ... This wiil display the Shell 

Sections dialog box. 

2- In the Shell Sections dialog box click on the Add New Section button. This 

will display Shell ~ecnons Data d1alog box. 

3- In the Sheil Sections Data dialog box 

• Enter the Section Name or accept the default name. 

• Select the materiai type by ciicking on the Iviaterial drop dow11 box. 

• Enter the Membnme <md Bending Thickness. 

• Choose the shell type to be Sheil, :rvrembrane or Plate. 

• Click OK. 

4- The new section name \viil be added to the Shell Sections list box. 

5- To Delete or lvlodify/Show Section, click on the Section name in the list box 

to select it and then c!ick on the Iv1odify/Shmv Section or Deiete Section 

button. 

6- Click OK. 

Add a SheB Section by defining the dimensions and I or pro-perties 

1- On the Define menu, click Sheil Sections ... This will display the Sheil 

Sections dialog box. 

2- In the shell Sections dialog box click on the Add New Section button. This 

wili dispiay Sheii Sections Data diaiog box. 

3- In the She1i Seclions D;-lla diaiog box 
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• Enter the Section Name or accept the default name. 

• Select the materia] type by clicking on the Mate1ial drop down box. 

• Enter the l'viembrane and Bending Thickness. 

• Choose the sheli type to be Shell, Membrane or Plate. 

• Click OK. 

4- The new section name \Viii be added to the Shell Sections list box. 

5- To Delete or Iviodify/Show Section, click on the Section name in the list 

box to select it and then click on the Modify/Show Section or Delete Section 

button. 

6- Click OK. 

Draw a Sheil Element between 4 Joints 

Draw in 2-D 

1- On the View menu click Sho\v Grids. This puts a check mark next to it and 

works as a toggle to rnm on or off the Grids. 

2- Select 2-D P1ane in which you \Vant to draw the member. 

3- Click on to switch to drawing a SHELL element benveen 4 Joints . 

4- Cliek on a Grid intersection, a previously defined Joint or any point in that 

plane. 

5- Click again on 3 other points either c.lockwise or colmtercloek\:vise to add a 

SHELL element. 

Note: lf you want to add a tiiangular element the fourth point eli eked should be 

the same as the first. 

Draw in 3-D 

.1- On the View menu, dick Show Grids. This puts· ~s;heck mark next to it and 

works as a toggle to tum on or off the Grids. 
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2- Click on to switch to drnwing a SI--lELL element between 4 Joints . 

3- ·In the 3-D view ciick on a Grid intersection or a prev1ously defined Joint (a 

small red ball appears to con linn that the point has been selected). 

4- Click on 3 other s·imiiar points either clockwise or cmmterclocJ..,vise to add 

a SHELL element. 

Note: It is not possible to draw a SHELL element between any 4 arbitrary 

points in space in the 3-D vie\v. 

A~sign i ,ocai Axc3 for S'1eH Elements 

l- Select one or more Shell Elements to \Vhich you want to Assign the same 

Local A-xes. 

2- On the Assign menu, click Sheii and then Local Axes ... in the sub-menu. 

3- In the Sheil Local Axis display box: 

• Type in a value for Angie in Degrees. Tllis is an angle by which local axis 

(2) of the Element wi11 be rotated around local axis 3. Local axis 3 is nonnal 

to the surface of tbe SHELL Element. By default local axis 2 is always in 

the 3-Z plane (and iies in the plane of the SHELL) except if the Element is 

horizontal and then it is parailel to the global Y-axis. The definition of the 

local axes follow the right hand mle. The angie is measured anti-clock\vise 

as positive if local axis 3 is pointing towards you. 

• Check the Reverse direction of normal box if yon \vant to flip the 

direction of local axis 3. 

• Cli.ck the 0 K button 

Note: The positive direction of rhe locai axis 3 is det~_:mined by the ·definition 

of the SHELL connectivitv. See Si£n Convention for more info. 
~ ~ 
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Assign Gravity Loads to Shells 

This loading method is a \vay to add the factored self-weight of the members in 

as a force in any of the global directions. lt is recommended that the actual 

self-weight of the stmcture be included in the definition of the Static Load 

Cases. 

1- Select one or more SHELLS to assign loads to . 

2- On the Assign menu, click Shell Static Loads and then Gravity ... in the · 

sub-menu. This \vill display the Shell Gravity Loads dialog box. 

3- In the Sheii Gravity Loads diaiog box: 

• Select the Load Case 

e Provide Gravity Multipliers 

• Select from Add, Replace, Delete 

4- Click OK. 

Tne sc-reen \viii refresh with a graphical representation of the load assigned on 

the members selected. 

Assign Uniform Loads to Shells 

1- Select one or more SHELLS to assign loads to. 

2- On the Assign menu, click Sheil Static Loads and then Unifonn... in the 

sub-menu. This \Viii display the Shell Unifonn Loads dialog box. 

3- ln the Sheil Unifonn Loads dialog box: 

• Select Load Case 

• Provide Unifonn Load value and Direction 

• Select from Add, Replace, Delete 

4- Click OK. 

1l1e screen \Vill refresh with a b,Yfaphica1 representation of the load assigned on . 

the members selected. 
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Assign Pressure Loads to Shells 

1- Select one or more SHELLS to assign loads to. 

2- On the Assign menu dick Shell Static Loads and then Pressure .. . in the 
~ , . 

sub-menu. This wiU display the Shell Pressure Loads dialog box. 

3- In the Shell Pressure Loads dialog box: 

• Select Load Case 

• Choose if pressure will be applied by Element or by Joint Pattern 

• If by Element, then specifY pressure value 

• If by Joint Pattern , then choose the pattern and multiplier 

~ Select from Add, R~.;p]ucc, Delete 

4- Click OK. 

The screen \Viil refresh \vith a graphical representation of the load assigned on 

the members selected. 

Assign Temperaiure Loads to Shells 

1- Select one or more SHELLS to assign ioads to. 

2- On the Assign memt, ciick Sheii Static Loads and then Temperamre ... in the 

sub-menu. ll1is wiH dispiay the Sheii Temperarnre Loading dialog box. 

3- In the Shell Temperature Loading dialog box: 

• Select Load Case 

• Choose the type of Temperature Loading, i.e. Temperature or Gradient 

• Choose if tempernture to be applied by Element or by Joint Pattem 

• If by Element, then specify temperature value 

• If by Joint Pattern , then choose pattern and muitiplier 

• Select from Add, R ~piace, Delete 

4- Click OK . 
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Reshape Element 

Reshape Element option is used to edit element fonns or shapes. With the help 

of this option it is possible to move FRAtviE or SHELL elements, stretch or 

shrink FRA~tlE elements and reshape SHELL elements. To move or reshape 

an element do the following: 

Add in 2-D 

1- On the View mem1 0 ciick Show G1ids. This puts a check mark next to it and 

works as a toggle to turn on or off the Gtids. 

2- Select 2-D Plane in which you want to reshape the member. 

3- Click on to swjtch to Reshape Element mode. 

4- Click once on a FR.Al'viE or a S.HELL element to select it. Tllis \vill clisplay 

the member end handles . 

5- Grabbing one of the handles of the element and moving it will stretch, 

shrink, rotate or reshape the element 

6- Grabbing the element (any point away from the handles) and dropping it at 

another location \:vill aiiow you to move the element. 

Add in 3-D 

In 3-D, the element editing works the same way as 2-D except that the handle 

may only be dropped at another pre-defined JOINT or G1id intersection. 

Note: Only one Element at a time may be moved or reshaped through this 

option. 

Add Special Joints 

In building a model in SAP2000 it is not necessary to pre-define Joints . The 

Joints are automaticaiiv added to the ends or corners of the elements. Special 
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Joints are those Joints, which are added by the user. These Joints may be 

necessary to add m rare cases such as at one end of an NLLink Element - an 

end where there ts no other element present and hence no automatically 

generated Joint. To add a Special Joint do the following: 

Add in 2-D 

1- On the View menu, click Show Grids. This puts a check mark next to it and 

works as a toggle to turn on or off the G1ids. 

2- Select 2-D Plane in which you want to add a Joint. 

3- Click on to switc.h to Arlrl Spr.r.i::~l Toint mode. 

4- Click on a Grid intersection or any other point in that plane to add a Joint. 

Add in 3-D 

1- On the View menu, click Show Grids. This puts a check mark next to it and 

works as a toggle to turn on or off the Grids. 

2- Click on to switch to Add Special Joint mode. 

3- In the 3-D view, click on a Grid intersection to add a Joint. 

Note: The Joints may oniy be added at grid intersections in 3-D view. 

Right Click on a Joint wili open Joint Infonnation edit box. You may edit the 

Joint location in this edit box to locate the Joint precisely in the desired 

location. 

Edit Grids 

Afler defining your coordinate system you can edit the location of the 

individual grids in the active coordinate system. 

1- On the Draw mem_1, ciick Edit Grid or. double click on a ~Yiid line in the 

h'Taphics screen. 
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2- in the ModifY Grids dialog box, Select Direction of the b>Tids you want to 

edit. 

3-In the location area: 

To l\1ove a Grid 

• Select the grid location from the iist. 

• Edit the grid ' s location in the text edit box. 

• Click the Move Grid Line button. 

To Add a new Grid 

• Enter the grid ' s location in the text edit box. 

~ Click the Add Grid Line bntton. 

To Delete a Grid 

• Select the grid location from the iist. 

• Click the Delete Grid Line button . 

4- lhe ue1ete Ali button '.vili delete ail the grids in the coordjnate system. 

5- Check the Lock Grid Lines if you \vant to lock the grid hnes from being 

moved using the method discussed in the note below. 

6- Check the Snap to Grid iines if you ·want the feah1re on. 
- r"t" " .....,, .... . . . ~-.. • ' ,. • • ,.... . . ., • • . . • . .. . 'I 

1- LnecK lJIUe JOints to lJnd Lmes n you want tne JOmts to move \Vltl1 tne 

grids. This is a very pmverfnl way to quickly edit the structure \vithout having 

to redefiJ!e JOmt locations. 

8- Click OK when finished. 

Note: From the display screen with the Reshape Eiement option set, you can 

add a new grid line by holding the CTRL-key dO\vn and clicking on an existing 

grid line and dragging away a duplicate. 
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Assign Joint Springs 

Springs are added to selected joints. 

1- Select the Joints to which you want to apply springs. 

2- On the Assign menu, click Joint and then Springs ... in the sub-menu. 

Tins will display the Joint Springs dialog box. 

3- In the Joint Springs dialog box: 

• Type in the Spring Sti:ffuess values in the iocal directions for the 

three Translations and the three Rotations. 

• In the Options area select the appropriate option - Add to existing 

springs, Replace existing springs or Delete existing springs. 

• If required specify the upper half of the Coupled 6X6 spring matrix, 

accessed by c.Jjcking the advanced button. 

4 Click OK. 

Equai Constraint 

A..n Equai Constraint causes ali of its constrained joints to move together 

with the same (or opposite) displacements for each selected degree of 

freedom, taken in the constraint local coordinate system. The other 

degrees of freedom are unaffected. 

Tne Equal Constraint differs from the rigid-body types of Constraints in 

that there is no coupling between the rotations and the translations. TI1is 

Constraint can be w~ed to: 

• Model syriunetty and anti-symmetry conditions with respect to a 

plane 

• Partialiy cot1i1~ct together different parts of the stmctural model, 

such as at e:-t~ansion joints and hinges 
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• For fully cmmecting meshes, it is better to use the Body Con.straint 

when the constrained joints are not in exactly the same location. 

Joint Connectivity 

Each Equal Constraint connects a set of two or more joints together. For a 

given Constraint, if any of the selected degrees of freedom are negative 

(i.e., opposite), only nvo constrained joints are allowed for that 

Constraint. Othervvise any number of constrained joints are permitted. 

The joints may have any arbitrary location in space, but for best results all 

jointF> Rhould Ghorc the ?.3m 1oonti011 iu !:Space if used fvt ~.;utu1edi11g 

meshes. Otherwise, moments may be generated that are restrained by the 

Constraint, which unreaiisticaliy stiffens the stn1cture. If this happens, the 

constraint forces printed in the output fi1e may not be in equilibrium. 

Such restrained moments may also be generated when Equal Constraints 

are used for symmetry purposes. They are necessary to enfcTce the 

desired symmetry or ami-symmetry of the displacements when the applied 

loads are not correspondingiy symmetric or ami-symmetric. 

Local Coordinate System 

Each Equal Constraint uses a fixed coordinate system, csys, that you 

specify. The default for csys is zero, indicating the global coordinate 

system. The axes of the fixed coordinate system are denoted X, Y, and Z. 

Seiecied Degtees of Freedom 

For each Equal Constraint you may specify a list, cdofs, of up to six 

degrees of freedom in coordinate system csys that are to be constrained. 

The degrees of freedom are indicated as UX, UY, UZ, RX, RY, and RZ. 
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A negative s1gn indicates a degree of freedom that is constrained to be 

opposite, e.g., -UX. 

Add Joints to an existing Constraint 

1- Seh!ct the Joints you want to add to an existing Constraint. 

2- On the Assign menu, click Joint and then Constraints . . .. in the sub­

menu. This will display the Constraints dialog box. 

3- In the Constraints diaiog box: 

• Choose the existing Constraint from the Constraints list box 

• Cliok OK 

4 TI1e Joints will be added to the existing Constraint. 

Assign Joini Constraints 

Constraints are applied to selected joints . 

. 1- Select the Joints to which you want to apply Constraints. 

2- On the Assign menu, click Joint and then Constraints .. . in the sub­

menu. TI1is will display the Constraints dialog box. 

3- In the Constraints dialog box: 

• Either select default names for different types of Constraints such as 

Beam, Body, Diaphragm, Equal, Local, P1ate, Rod or Weld or 

• Add a new ConstTaint by clicking on the Add drop down list and 

selecting the appropriate type of constraint. Type in the new name or 

accept the default name, choose the axis (X, Y or Z) or Auto to define 

the direction ofthe constraint and then click OK. 

4- Click OK. 
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Getting a Head Start With Templates 

New models may be created with very little effort using pre-programmed templates. 

Click on any of the template buttons to learn more about them. 

To Base a new model on a template: 

1 On the File menu, click New Model from Template ... This will display the possible templates shown above. 

2 Click on a template most appropriate for your model. 

3 ChQO:?e or change the default values in the edit boxes. 

4 Click OK. 

To add one or more templates to the existing model: 

1 On the Edit menu, click Add to Model From Template .. . This will display the template options similar to the one 
shown above. 

2 Click on the template you want. 

3 Fill in the parameters in the edit boxes and then click on to specify an insertion point. 

4 Click OK. 

Note: Remember to save your model perio<lically. Click on 
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Assign Options 

Cficking on any of these buttons IIi!.: j I: .j~j ~:~J:±.dc@J:' . I from the allows you to Assign 

properties, loads and restraints/constraints to your selection. Members or Joints have to be selected first in order to make an 
assignment. 

Select various Assign options by clicking as follows: 

To Assign 

Supports or Restraints to Joints 
rm 

Clickon ~ 

Sections to Frame Elements 

rr:;:=n 
Clickon ~ 

Thickness to Shell Elements Click on ~~~~~ 
Loads on Joints 

m 
Clickon ~ 

Span and Point Loads on Frame Elements 
rmJ 

Clickon ~ 

Uniform Loads on Shell Elements 
~ 

Clickon ~ 

36 



' ' . 
SAP2000 

Draw Mode 

. . l :l]l• r:;d~iJ~~~oldll . 
Clicking on any of these buttons · T · ·· .. · T. Jq .. · · · from the 
mode. 

The Draw mode allows for drawing of new members and editing one element or a joint at a time. 

Draw Mode is also the default mode when a NEW model is started. 

Select various Draw options by clicking as follmvs: 

To Draw or Edit 

~ 

puts SAP2C(X) in the Draw 

EdiUShapeJMove Element Click on ~ and click on a joint or Element. Use the handles 
to move or stretr.h. 

An extra or Special Joint 

A Frame Element (joint to joint) 

Quick draw Frame Elements 

A Shell Element (joint to joint) 

Quick draw Shell Elements 

Click on IL~JI and click on any point to add a Joint 

8 
8 j 
[g] 
[Q] 

. 
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Display Options 

Cnicki f th butt 
j:l~lJ~;j .~J:r:fW.ll f the 

ngonanyo ese ons · · - · · rom or some buttons from the Toolbar 

allows you to Display your selection with varied options. 

Select various Display options by clicking as follows: 

To Display 

Undeformed geomeby 

Isometric view (toggle) 

2-D VIew (XY, XZ or yz plane) 

:3:-D VIew ' · 

Deformed Shape 

Element Stress Diagram 

Joint, Frame or Shell Loads 

Patterns 

Tabular Input 

Mode Shapes 

Tabular Output 

Response Spectrum 

Time History 

Shrunken Elements (toggle) 

Selective Elements 

rFn1il 
Clickon ~ 
~ 

Clickon ~ 

Click on any one of the buttons 
that specific plane. 

Clickon Kml 
Click on 11:~~~ or Display menu and Show Deformed Shape 

Click on [il] or Display menu and Show Element Stress Diagram. 

Right click will show the details. 

Click on Display menu and Show Loads. 

Click on Display menu and Show Patterns. 

Click on Display menu and Show Input Tables. 

Click on IL~JI or Display men~ and 

Click on • or Display menu and 

Click on Display menu and 

Click on Display menu and 

Click on m or click on j[!@.!!l and select shrink. 

~ 
Click on ~or Vi£m menu and 
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